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1. Navigation  
  

Objectives:   

1.1 Install TOPSpro Enterprise (TE)  

1.2 Open TE  

1.3 Explore the menus and submenus  

1.4 Explore the relationships of records and database hierarchy  

♦♦♦  

1.1. Install TOPSpro Enterprise (TE)   
  

1.1.1. From your Internet browser, type www.etestsonline.org/html5. This is the Website 

where you can install TE online.  

 

 
 

1.1.2. Click Install TE Client on the upper left hand corner of your screen.  

  

1.1.3. Follow the prompts from your Web browser to save and/or run this file.  

  

1.1.4. When the prompt appears, click Install. It will take a few minutes to install TE, 

depending on the speed of your Internet connection. TE will automatically open 

once the installation is complete.  

  

  

 

https://etestsonline.org/html5#/
https://etestsonline.org/html5#/
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1.2. Open TE  
  

1.2.1. Start the program by double-clicking the TE icon located on the computer 

desktop. If you just installed TE, this icon appears on your desktop 

automatically during installation.  

  

  

  

  

  

1.2.2. Log in using the credentials below. The facilitator will provide you with a specific 

User profile.  The password is admin.  

  

 
  

         

1.2.3. Click Connect or press ENTER on the keyboard.  
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1.3. Navigate the menus, submenus, and icon bar  
  

TE uses a similar type of menu system that you see in most Windows-based applications. 

Look at the menu bar.     

 
  

1) The left side of the bar shows the menu bar options: TE, View, Organization, Records, 

Reports, Tools, and Help.   

2) To the right is the title bar. It displays your Username and the version of TOPSpro 

Enterprise that you are using, and other options to adjust your screen size.   

    
  

Now let’s take a look at some of the menu features. Do not worry about using any of these 

functions yet – just point to the different features menu so you can see how TE organizes its 

menu.  

1.3.1. Find the TE Menu icon and click once. Highlight each menu option.  

 

1.3.2. On the View menu, point to Large. Note the change in font 

    size on the menus.    

  

1.3.3. On the Organization menu, point to Classes, and select 

    Definitions.  

  

1.3.4. On the Records menu, point to Programs, and select 

    Enrollments. 
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1.3.5. On the Reports menu, point to Demographics, and point to Demographic 

Summary.  

 
    

  

1.3.6. On the Tools menu, select TE to TE Import/Export Wizard.  

  

1.3.7. On the Help menu, point to Contents.  

  
  

  

EXERCISE 1.1  
  

1.  Which Website enables you to install TE?  

  

2.  How would you change the Display to a larger font size?  

  

3.  How would you open the Learning Gains Summary report?  

  

4.  Where would you import data from a 3rd party system?  

  

5. What is the difference between the listers featured on the Organization menu and 

those on the Records menu? 
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1.4. Explore the relationships of records and the database hierarchy  
  

1.4.1. On the Organization menu, click Agencies.  

 

  
 

1.4.2. Near the top of the TE reporting hierarchy is the Agency. Place the cursor on top 

of the Agency Name that is highlighted in blue. Double-click the agency name 

with the left-mouse button.  

 

  

  

1.4.3. A new tab containing agency information will open. 

View the Navigator section of this window to the left. 

Edit/View is highlighted indicating that the data for  

this agency is editable. 

  

  

   

1.4.4. Click Sites. Each Agency in TE contains one or  

more Sites. Sites can be a physical location or a 

cluster of locations within the agency.                          
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1.4.5. Double-click the first site, Site 1, North Campus.  

 

 

 

 

 

 

 

 

 

 

 

 

1.4.6. The Site Information tab should open.  

  

1.4.7. Once again, the Navigator bar opens to 

Edit/View, and displays the basic information 

about this site.   

  

1.4.8. Click Class Definitions. Each Site contains one 

or more Classes.  

 

Place the mouse on top of the first class 

on the list, Class 1, Low Intermediate 

ABE.  Double-click the record.  

  

  

The Class definition tab opens again 

with the Navigator bar on the left and 

Edit/View at the top.    

  

1.4.9. Click Class Instances. This displays a record 

with more detailed information about that class.   

   

  

1.4.10. Double-click anywhere on the row to open 

the record listed.  
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1.4.13. Click Class Records. This displays a duplicated list of students in the class, with 

a separate record created each time new information is updated for that student.  

  

1.4.14. On the right hand side of the screen, find the 

Pages tab to open a new menu. On the Pages 

menu, select Close all Pages to clear your 

screen.   

  

  

  

  

  

  

  

  

  

  

  

                         

  

1.4.11. Once again, this record includes a Navigator 

bar that includes different selections related to 

the record that you opened. 

  

  1.4.12. Click Class Enrollments.  This displays an 

unduplicated list of students assigned to this class. 
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 Congratulations! 

You have successfully navigated throughout TE. 

  

  

EXERCISE 1.2  

1.  What is the Agency number for Rolling Hills Adult School? 

2.  How many Sites are included in Rolling Hills Adult School? 

3.  How many Classes are included in Site 2, South Campus? 

4. How many Students are enrolled in the North Campus Class 1, ABE?   

5. How many total records are there in Class 1 ABE when you click 

Class Records?    

6. Who is the first Student listed in the North Campus Class – 424 – ESL morning?  

  

7.  Which Class has a higher enrollment – 424 ESL morning, or 432 ESL high?    

  

 8.  How many Students are assigned to Site 2 – South Campus?    
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2. Verifying & Editing Data   
  

Objectives:  

2.1. Use TE listers to find records  

2.2. Explore and Edit Student Records  

♦♦♦  

  

  

2.1. Use the TE Listers to find records  
  

There are several selections included in the Organization and Records menus. These are 

the two menus in TE that include listers.   

  The Organization menu includes listers that pertain to the agency’s organizational  

structure--featuring “container” records such as agency-site-class, features that help  

 
  

manage database security, and staffing related records.   

    

  The Records menu includes listers that contain more detailed student level information, 

such as student demographics, and specific fields that link a student with a class or  

 program.  

  

Each name in this menu indicates the specific information that it contains. For example, the 

selection under Organizations/Sites is the table that contains site records. If you go to 

Records/Tests, that is the table that contains a list of tests.  

2.1.1. On the Records menu, point to Students, and then click In Program Years.     
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2.1.2. The Student In Program Years Lister will open.    

  

2.1.3. The contents of the lister will then appear. Each row that you see represents an 

individual record. You can single-click anywhere on the row of the record to 

highlight it. Double-click anywhere on that row to open, view, or edit a record.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.4. Notice the action buttons on the lister toolbar at the top of your screen.    

       
  

2.1.6. You can quickly view the number of students in the lister by looking at the figure at 

the top. In this example, there are 463 records in the Lister.   

  

 
  

  

  

  
       

2.1.5 .  Locate additional buttons by clicking  

the  More  button to the right of the  

other action buttons.  
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2.1.7. You can limit your Lister display to a particular Site by using the Site filter box.  

Click the arrow to the right of the Agency/Site filter box. A drop-box will open. 

Click Site 2, South Campus.  

  

  

  

This will limit your list of 

students to only those 

attending that Site.  

  

2.1.8. Use the same Agency/Site 

filter box to restore the list 

back to Agency 4908.  

  

 

2.1.9. Use the Filter, Columns, and Sort buttons to organize the display of your lister.  

  

  
  

• Filter allows you to limit your lister display only records that meet 

specific criteria that you select.  
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• Columns enables you to select and de-select which columns will display 

in your lister.  

 
• Sort is where you designate which field determines the display order of 

your lister, for example the screen shot below shows a lister sorted 

numerically by Student ID.  
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2.2. Filter, Sort, and Select Columns in TE Listers   
  

TE also provides users with simple options to quickly retrieve information, and to customize 

listers to display preferred fields.   

  

2.2.1. On the Records menu, point to  

Students, and then click 

Demographics.  

  

2.2.2. Right click on the column header for 

Races. Click Hide Races to remove 

this column.  

  

2.2.3. Performing this enables you to hide the 

column you selected or add additional 

fields.   

  

2.2.4. Repeat the steps by right-clicking 

Ethnicity and also removing that 

column from the lister.  

  

  

 

2.2.5. Now, we want to add a new column instead of subtracting an existing one. Right 

click the grey space to the right of the lister columns. This generates a list of 

columns that you can add. Select Show Age.   

   

2.2.6. On the Gender column, click the Add Filter  

icon to open the filter box for that column.  

Check Female.   

  

   

2.2.7. Click the same icon in the Age column, and type in 

the age range of 33 to 43, as in the graphic below. 

Click OK.   
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2.2.8. You now have a filtered list of all female students from the age of 33 to 43.   

  

2.2.9. Click the Add Sort icon in the Age column. This arranges the list in 

order from age 33 to 43. Clicking a second arranges it in reverse—

from 43 to 33.   

  

2.2.10. Click the red “X” in both the Age and Gender columns to restore back 

to the full list of students.   

 

 

  

EXERCISE 2.1  

 

 

1.  How many Current Students are there in Rolling Hills Adult School?  

2.  How many Current Students are there in Site 11 North City ESL?    

3.  What is the Student ID for Marlon Sneed?   

4.  Which Student is assigned ID 599661101?    

5.  Which Student in Site 11 North City ESL has the earliest Date of Birth?  

 

6. How many Female Students are there in the program year at Rolling Hills 

between the ages of 23 and 29?  

 

7. How many students enrolled in Site 2, South Campus with native language of 

Spanish?  
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2.3. Explore and edit student records   
  

The Student Demographic record is the "parent" record for all other learner-related records, 

such as In Program Years, Test, and Class Enrollment records (which are all “child” 

records.) The foundation for the Student Demographic record is the Student Identification 

(ID) number, which provides the common element that links all of the records assigned to the 

student, and supplies the minimum information TE needs to create a Student Demographic 

record.  

  

2.3.1. On the Records menu, point to Students, and then click Demographics,   

  

2.3.2. Find the record for the student Acuna, Rosalina, by clicking the Filter icon in the Name 

field and searching for Acuna. (Note: be careful how you set up this filter.)  

  

 
  

2.3.3. Open the record for Rosalina Acuna by double-clicking anywhere on the row of that 

record.  

  

2.3.4. The Student Information tab should open.  

  

    

Do a guided tour of Rosalina’s records.  
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2.3.5. View the Navigator section of this window on the left-

hand side. It opens to Edit/View, which enables you to 

edit and view Rosalina’s personal student demographics 

information. Edit/View contains the “parent record” data 

for the student record, while the other selections on the 

Navigator bar represent “child records.”  

  

2.3.6. Clicking the different options on the Navigator panel 

provides views of a variety of information about that 

student.  

  

  

  

2.3.7. In Program Years displays the years in which 

Rosalina has dated activity in the database.  

  

  

  

  

  

    

  

2.3.8. Student Records displays a list of all of the dated activity that occurred for Rosalina              

during the year.   
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2.3.9. Class Enrollments lists each class in which the student is enrolled. This list will only 

include one listing for each class.  

 

 

 

 

 

 

 

 

 

 

 

 

2.3.10. Class Records shows all class related activity for the student. This section includes 

separate records for all data activity related to the class.  

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.11. Program Enrollments lists each program in which the student is enrolled. This section 

will only include one listing for each program.  
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2.3.12. Program Records shows all program related activity for the student. This includes 

separate records for all data activity related to the program.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.13. Tests displays Rosalina’s tests. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2.3.14. Return to Edit/View.  

  

 

 

 

 

 

 

 

 

 

 

 



                                                                                                                      

  

©   CASAS 201 8 
  

21   

 

 

  

2.3.15. Click the Edit icon. This opens the Edit/View screen for editing.  

  

 
  

  

2.3.16. In Identification, find the Date of Birth field.  

  

  

2.3.17. Change Rosalina’s date of birth from 5/9/1991 to 5/9/1992.  

 

 

 

 

 

 

 

 

 

 

EXERCISE 2.2  

 

1.  What is Rosalina Acuna’s Date of Birth?  

2.  What is Rosalina’s Native Language?      

3. How many Test records does Rosalina have for the current program year?    

4. What is Rosalina’s Secondary Attainable Goal?      

 

5.  What is the Highest Year of School Completed for John W. Bestway? 

  

6.  [ADVANCED] On what date was John’s first Update completed?      

 

7.  [ADVANCED] How many different programs is Chuckie Garcia 

     enrolled for current program year? How many classes?   

 

  

Congratulations!   

You have successfully explored, edited, and designed student records in TE.  

 

2.3.18. Click Save. 



       

  

22   © CASAS 201 8 
  

 

    
3. Manual Data Entry  
  

  

Objectives:   

3.1 Enter Student Demographics  

3.2 Create a Class and a Teacher  

  

  

3.1. Enter Student Demographics  

3.1.1 On the Records menu, point to Students, and select Demographics.  

  

3.1.2 Click the New icon.  

  

  

  

  

  

3.1.3 Enter information for the new student as it appears in the graphic on the 

next page.   

  

3.1.4 When finished, click Save.   

  

3.1.5 Return to the Student Demographics lister.   

  

3.1.6 Click the Add Filter icon         in the Student ID column and type in the 

Student ID 555778989. Click OK.  

 

  

  

 

Click on the Filter button                        and remove filter for   “Current Program Year” and   

  

press OK.  The new student demographics record for Elvin Miles should now appear.              
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3.2. Create a Class and Assign a Teacher  

3.2.1 On the Organization menu, click Sites.  

  

3.2.2 Open the record for Site 11 – North City.  

  

3.2.3 On the Navigator bar, click Class Definitions.  

 

  

3.2.5 Enter information for a new Class 113 using the data in the graphic below.  

 
  

  

  

     

3.2.4   Click the  New  icon.     
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3.2.6 Click Save. Notice that additional selections appear on 

the Navigator bar.  

  

3.2.7 On the Navigator bar, click Class Instances.  

  

  

  

3.2.8 Click the (lower) New icon. 

  

3.2.9 Enter the information using the following information:  

 

 

 

 

 

 

 

 

 

 

 

 

  

 

  

3.2.10 Click Save. Again, new selections appear on the Navigator bar.  

Now we will add a couple of students and a teacher to this new class.  

  

3.2.11 On the Navigator bar, click Class Enrollments.  

  

3.2.12 Click New.   

  

3.2.13 Open the Student drop-down menu.   
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3.2.14 Select student David Vega and click Save. Repeat the same process with 

student Lena Lukashuk. 

 

  

3.2.15 Return to the Class Instance Record and click Class Enrollments. Note that 

these two students now appear in this lister.  

 
3.2.16 Click the open tab for the class definition record you originally created for 

Class 113.  

  

3.2.17 On the Navigator bar, click Teachers.  

  

3.2.18 Click the (lower) New icon.   

  

3.2.19 Enter new teacher information based on the graphic on the next page.   
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3.2.20 Click Save.   

  

3.2.21 On the Pages tab, click Close All Pages.  

  

  

  

  

  

  

  

  

  

  

  

  

6/30/2020 
  

7 / 01 /201 9 
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4. Scanning  
Objectives:   

4.1 Scan New Records in TE  

4.2 Edit and Verify Scanned Data in TE   

  

  

  

  

  

  

  

  

  

  

  

  

  

4.1.Scan new records in TE  

4.1.1 On the Tools menu, select Scanning Wizard.   

  

4.1.2 When scanning at your agency, choose Using Scanner and then click Next.   

 
  

4.1.3 But for this training, choose Simulate Scanning. Click Next.  

  

  
  

4.1.4  Select Entry for the Front Side, and for Back Side, select None.  
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4.1.5 Click Next  

  

4.1.6 In the Windows dialog box, find the Entry Record simscan file to simulate 

scanning. Click Open. (Note: your file will differ from the graphic below. The 

facilitator will provide you more instructions on this step.)  

  

    
4.1.8 Check Select field overrides and then click Next.   

  

  
  

4.1.9 In Front Overrides input the following information below.   

 
4.1.10 Verify the additional settings on the next screen and Click Next.   

  

  

  

  

  

  

  

4.1.7   Click  OK , and then click  Next .   
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4.2.Edit and Verify Scanned records in TE  

The next step displays the list of the records you just scanned. Here is where we can “batch 

repair” the records we created during our scan session, and also add the name(s) for the 

students we entered.  

  

4.2.1 Select a record for editing and then double-click that record, or click Edit 

Records. This opens the Data Correction Edit Window.   

  

4.2.2 Edit the record like the example in the graphic below. (Note: your example 

may differ from the data represented in the graphic. Your instructor will 

provide more directions if necessary.)  

 
4.2.4 On the Scan Wizard, click Next.  

  

4.2.5 Click Next to import the record(s) into TE.  

  

4.2.6 Click Finish.  

  

  

  
  

4.2.3   Click  Save .  
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5. TE User Accounts  
  

  

Objectives:   

5.1   Create a New User in TE  

   

  

  

  

  

  

  

  

  

  

5.1.Create a new user in TOPS Enterprise  

5.1.1 On the Organization menu, select Users.   

  

5.1.2 Click New.   

  

5.1.3 Create the new user account according to the graphic below. For the password type 

in coordinator, all lowercase.   
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5.1.4   Select Coordinator (TE) Access from the Groups drop down menu.  

  

 

  

  

5.1.5    Fill in the User Contact info.   

  

  

  

 

  

  

5.1.6   Click Save.  

    

  

6. Generating Reports  
  

Objectives:   

6.1. Locate reports using the TE menu  

6.2. Generate reports using the New Report Setup 

window  
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6.3. Display, print, and navigate throughout TE reports  

6.4. Use dynamic “drill down” features in TE reports  

6.5. Filter TE reports using Report Viewer Navigator  

  

  

  

♦♦♦  

  

6.1. Locate reports using the TE menu  

  

6.1.1. Click the Reports drop-down menu.  

 

  

As you can see, there are several submenus or categories of reports in TE. Each submenu 

includes reports that all relate to similar topics. By scrolling to each category, you can find out 

which reports that specific section contains. More reports will be added to TE in future 

development.  

  

  

6.1.2. On the Reports menu, point to Demographic Reports, and then click 

Demographic Summary.   
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6.1.3. The Report Setup window will open. This opens whenever you select any report 

in Enterprise. In this window you determine what specific information will appear 

in the report.   

  

 

A. Report Setup Navigator enables the user to filter the report using a variety of 

criteria, such as by specific student or class. Selections on the Navigator 

panel vary depending on the content of the report.  

  

  

  

  

A   
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ID or alphabetically by Name. Some of these options vary according to the 

specific report you generate.  

D. Special Options varies from report to report, and is where you can assign 

specific conditions to that report generation, such as breaking on class or 

program, or showing the students’ complete test history.  

  

  

  

  

For this exercise, we will start by simply generating the report with no modifications to the 

setup.   

  

We do this by clicking the Generate button or icon.  

6.1.4. Click the Generate button. This opens the  

  

B.  Program Years and  

Date Ranges  is where  

you indicate the record  

dates for the report. For  

example, in the setup  

window above, the report  

will include data from the  

current program year.  

Program Years  enables  

you to select a specific  

fiscal year range, while  

Date Ranges  enables a  

more detailed range of  

dates.  

C.  Output Layout  

Parameters  includes  

other selections that give  

you flexibility to  

customize the output of  

your report. This section  

has features such as  

Report Sort Order,  

Page Sort Order , and  

Print Options  enabling  

the display either  

numerically by Student  

D 

B   

C   



       

  

36   © CASAS 201 8 
  

Demographic Summary report. You can scroll up ↑ and down ↓, and 

across →  to view the report. We will explore this and other reports further in the 

next Lesson.   

  

6.1.5. To enhance your view of the report, click 

the Unpin icon to minimize the Report 

Viewer Navigator.  

  

  

6.2. Display, print, and navigate throughout Enterprise reports   

  

6.2.1. Refer to the report you generated. If you need to re-open it, from the Reports   

menu, point to Demographic, and then click Demographic Summary.  

  

6.2.2. Click the Generate button. The report will open.  

  

 
  

  

  

  

  

6.2.3. There are a variety of icons that run across the top of the report that enable you to 

perform certain functions. To the left are buttons that appear like this:  
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A. Keep Session allows you to save the report so you can open the report in the TE 

Reports Manager at another time with the exact setup modifications you 

selected in the setup window.   

B. Export enables you to save the report in different file formats so you can view 

the data in other programs. Most TE reports allow export to Word, Excel, Adobe 

PDF, and Rich Text Format.  

C. To print a hard copy of the report, click the Print icon.  

D. The navigation buttons allow you to go to a particular page within the report.  

E. Layout Settings enables you to make changes to fields in the setup window 

without having to close the report.   

F. Fit Page, and Fit Width adjust the view of the report in different ways.  

  

  

  

Now we will regenerate this report. Click Layout Settings.   

  

 
6.2.4   In Chart Type, select the pie chart icon; in Pie Chart Descriptors, select Labels, and 

then click Apply (at the bottom of the screen.)  
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6.2.5  The report now displays in both table and pie chart format, with labels to 

denote each demographics category.  

  

6.2.6  Close the Demographic Summary report and the report setup window.  

  

6.3.Use dynamic “drill down” features in TE Reports   

  

6.3.1  On the Reports menu, point to Data Management submenu, and select Data 

Integrity.  

  

6.3.2  Leave the settings as is in the setup window, and click Generate.  

  

6.3.3    Click the Unpin icon to provide a full view of the report.  

  

  

6.3.4  View all of the figures displayed on this report. Hover with your cursor over one of 

the figures to highlight the number, as shown in the graphic (below).  

  

  

6.3.5  Click the figure on the 

report that you highlighted. A 
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new Lister appears, that displays a list of the learners included in that 

number. In this example, clicking the number “231” on the report 

generates a list of the 231 learners eligible for WIOA.  

 

6.3.6  Double-click the top record on the list (in this example, Trayla B. Ford) to open           

that student record.  

6.3.7  This directs you to that learner’s record so you can immediately view and/or 

correct the issue displayed on the Data Integrity Report.  

  

6.3.8   Note the orange bar that now appears. This signals that you have drilled down to 

a specific subset of data included in the report. (Note: clicking the red “X” to the right of 
the orange bar removes the drill down filter you selected, but will not return to the full 
report.  Double-clicking on the white text in the orange bar will return you to the full 
report.)  

 
  

  

    
  

6.4. Filter TE reports using Report Viewer Navigator  

6.4.1  Click the report title at the top of the Navigator panel to return to the full report.  
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6.4.2 The other selections in Report Viewer Navigator will direct to different TE listers 

that provide a variety of views that relate to the data cell on which you drilled down.  

  

Generally, Students – In Program Years is the option to select if you want to 

ensure that the item count in the lister matches the items count displayed in the 

report cell.  

  

The other selections below Students – In Program Years provide more detailed 

views to facilitate editing and correction of data.  

  

  

6.4.3  Click Students – Records. Note the item count for this lister is much larger than 

Students – In Program Years, as it includes a duplicated list of students.  

  

6.4.4  Open the top listed record (for this exercise, it should be Sofia Fraticelli.) This 

takes you directly to the student’s data, where you can add or correct the fields listed “on 

the spot.”  

  

6.4.5  Close the student record, and close the Data Integrity Report, but leave the setup 

window open.  

  

    

6.4.6  In Report Setup Navigator, click In Program Years.   
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This generates a list of all students in the selected program 

year who qualify for this report. Note that the item count is the 

same as for the total number of WIOA learners we reviewed in the previous exercise.  

  

  

6.4.7 In the Lister, use the column filters to              

replicate the same filter we performed in              Lesson 

2 – in Age, filter for students only              between the 

ages of 33 and 43, and in              Gender, select 

Female.   

  

  

  

6.4.8 On the top row, click Generate. The report now displays data integrity results for               

the filter we directed – for only female students between the ages of 33 and 43.  

 
  

Congratulations!  
You have created and interpreted reports and evaluated                                        

TE report selection criteria.  
  
  

  

EXERCISE 6.1  
  

  

1. List at least three students who appear on the Data Integrity report under Item #2 – Less 

than 12 hours of instruction:  

  

2. What percentage of Rolling Hills WIOA II learners have a conservative estimate pretest 

score?  

_________________________________________________________  

  

  

  

6.4.9   Close all tabs (Pages, close all pages.)  
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3. How many students at Rolling Hills have a Native Language of 

Spanish?  

____________________________________________________________  

  

4. According to the database, are there more students at Rolling Hills who are Employed or 

Unemployed?  __ __________________________  

5. What are at least two reports available that can display this information?  

  

Any of the following:   

  

  


